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HOW TO SPEED UP DATA ENTRY DUPLICATES BY USING THE AUTOCOMPLETE FEATURE. 

When you start to type something in a cell, Excel can try and òguessó what you are typing and shows a 

highlighted "match" that you can accept simply by pressing Enter or Tab.  

 

Example: the letters òJaó have been typed into A6, and a òguessó is returned. 

The "matches" that Excel uses in its "guess" are the contents of the cells in the column. For instance, if 

you have information in cells A1 through A6 and you are entering a value in cell A7, Excel looks at what 

you are typing. If the first few characters uniquely matc h something in any of the six cells previously 

entered in the column, then Excel offers to AutoComplete A7 with the contents of the cell that 

matched.  

AutoComplete will only offer matches from cells that are directly positioned above or below the active 

cell ð in the above example, if there is a blank cell in A6 and you type something in A7 that is already 

listed in A1:A5, no òguessó will be made due to the blank A6 cell. 

 

Example: the letters òJaó have been typed into A7, but A6 prevents an AutoComplete òguessó. 

In addition, Excel does not try to match with cells that contain only numbers, dates, or times. The cells 

must contain either text or a combination of text and numbers.  

For some people, AutoComplete can be annoying rather than time -saving. If you want to turn off the 

AutoComplete feature, follow these steps:  
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Excel 2003 Process:    

1) On the Tools menu, click Options.   
2) On the Edit tab, select or clear the Enable AutoComplete   for cell values check box to turn 

automatic completion of cell entries on or o ff.  
Excel 2007 Process:    

3) Click the Office button  and then click Excel Options . Excel displays the Excel Options 
dialog box.  

4) At the left side of the dialog box click Advanced .  
5) Clear the check box named Enable AutoComplete for cell values.  
6) Click on OK. 

 

To turn AutoComplete on, reverse the above steps.  

 

 

USING CTRL AS A FUNCTION KEY 

 

(effectively you will be pressing Ctrl+Shift+9 for example)  

CTRL+( Unhide any hidden rows within the selection.  

CTRL+) Unhide any hidden columns within the selection  

CTRL+& Applies the outline border to the selected cells  

CTRL+_ Removes the outline border from the selected cells  

CTRL+~ Applies the General number format  

CTRL+$ Applies the Currency format with two decimal places (negative numbers in parentheses)  

CTRL+% Applies the Percentage format with no decimal places  

CTRL+^ Applies the Exponential number format with two decimal places  

CTRL+# Applies the Date format with the day, month, and year  

CTRL+@ Applies the Time format with the hour and minute, and AM or PM  

CTRL+! Applies the Number format with two decimal places, thousands separator, and minus sign 

(-) for negative values  

CTRL+- Displays the Delete  dialog box to delete the selected cells  

CTRL+* Selects the current region around the active cell (the data area enclosed by bl ank rows 

and blank columns) 

CTRL+: Enters the current time  
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CTRL+; Enters the current date  

CTRL+`  Alternates between displaying cell values and displaying formulas in the worksheet  

CTRL+' Copies a formula from the cell above the active cell into the cell or  the Formula Bar 

CTRL+" Copies the value from the cell above the active cell into the cell or the Formula Bar  

 

CTRL++ Displays the Insert  dialog box to insert blank cells  

CTRL+1 Displays the Format Cells  dialog box 

CTRL+2 Applies or removes bold formatting  

CTRL+3 Applies or removes italic formatting  

CTRL+4 Applies or removes underlining  

CTRL+5 Applies or removes strikethrough  

CTRL+6 Alternates between hiding objects, displaying objects, and displaying placeholders for 

objects  

CTRL+7 Displays or hides the Standard  toolbar  

CTRL+8 Displays or hides the outline symbols 

CTRL+9 Hides the selected rows 

CTRL+0 Hides the selected columns 

 

FUNCTIONS KEYS 

F1 Displays the Help Task Pane  

CTRL+F1 closes and reopens the current task pane.  

ALT+F1 creates a chart of the data  in the current range.  

ALT+SHIFT+F1 inserts a new worksheet.  

F2 Edits the active cell and positions the insertion point at the end of the cell contents. It also 

moves the insertion point into the Formula Bar when editing in a cell is turned off.  

 SHIFT+F2 edits a cell comment.  

 

F3 Pastes a defined name into a formula.  

SHIFT+F3 displays the Insert Function  dialog box.  

 

F4 Repeats the last command or action, if possible.  

CTRL+F4 closes the selected workbook window.  
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F5 Displays the Go To dialog box.  

CTRL+F5 restores the window size of the selected workbook window.  

 

F6 Switches to the next pane in a worksheet that has been split ( Window  menu, Split  command). 

SHIFT+F6 switches to the previous pane in a worksheet that has been split.  

CTRL+F6 switches to the nex t workbook window when more than one workbook window is 

open. 

 

F7 Displays the Spelling  dialog box to check spelling in the active worksheet or selected range.  

CTRL+F7 performs the Move command on the workbook window when it is not maximized. 

Use the arrow keys to move the window, and when finished press ESC. 

 

F8 Turns extend mode on or off. In extend mode, EXT appears in the status line, and the arrow 

keys extend the selection.  

CTRL+F8 performs the Size command (on the Control  menu for the workbook windo w) when a 

workbook is not maximized  

CTRL+F8 performs the Size command (on the Control  menu for the workbook window) when a 

workbook is not maximized.  

ALT+F8 displays the Macro dialog box to run, edit, or delete a macro.  

 

F9 Calculates all worksheets in all  open workbooks.  

F9 followed by ENTER (or followed by CTRL+SHIFT+ENTER for array formulas) calculates the 

selected a portion of a formula and replaces the selected portion with the calculated value.  

SHIFT+F9 calculates the active worksheet.  

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they 

have changed since the last calculation.  

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then  

calculates all cells in all open workbooks, including cells not marked as needing to  be 

calculated.  

CTRL+F9 minimises a workbook window to an icon.  

 

F10 Selects the menu bar or closes an open menu and submenu at the same time.  
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SHIFT+F10 displays the shortcut menu for a selected item  

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is 

present, it switches to the next smart tag and displays its menu or message.  

CTRL+F10 maximises or restores the selected workbook window.  

 

F11 Creates a chart of the data in the current range.  

SHIFT+F11 inserts a new worksheet. 

ALT+F11 opens the Visual Basic Editor, in which you can create a macro by using Visual Basic 

for Applications (VBA).  

ALT+SHIFT+F11 opens the Microsoft Script Editor, where you can add text, edit HTML tags, 
and modify any script code.  

 

F12 Displays the Save As dialog box.  

 

HOW TO COPY SEVERAL INDIVIDUAL, DISTINCT AREAS ONTO ONE WORKSHEET AND HAVE 

THEM LINKED TO THE SOURCE, BY USING PASTE PICTURE LINK. 

There are a few options when consolidating information from multiple worksheets. The option we are 

looking at in this tip will enable you to paste the copied cells as objects (pictures). Pasting them as 

objects is useful as you can resize the objects.  

This tool is helpful when needing to print multiple areas of a workbook onto one worksheet or creating 
a dashboard summarizing parts of the workbook.  

Microsoft Excel 2003 process:  

1. Select the desired range to be copied 
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2. Right click the selected  range, select Copy 

3. Navigate to the destination  worksheet 

4. Hold down Shift  on the keyboard  

5. From the Menu bar, select Edit , Paste Picture  Link  

 

 
 

6. Your object  (picture) will now be pasted  and can be resized  as desired 

7. Repeat the above steps for additional  objects  

 
Microsoft Excel 2007 process:  

1. Select the desired range to be copied  
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2. Right click the selected  range, select Copy 

3. Navigate to the destination  worksheet 

4. From the Home tab, in the Clipboard  group, select the down  arrow under Paste 

5. Select As Picture , Paste Picture  Link  

 

 

6. Your object  (picture) will now be pasted  and can be resized  as desired 

7. Repeat the above steps for additional  objects  

 



 

 

Website: www.alchemex.com    BI Community:  www.alchemex.ning.com    
  

Online Academy: www.alchemexacademy.com 
12 

THE QUICK WAY TO SELECT A RANGE OF CELLS BY USING CTRL + SHIFT + * 

It can be time consuming to use your mouse to select a range of cells. To speed up this process, you 

can use Ctrl + Shift + *  

Microsoft Excel 2003/2007 process:  

1. Select any cell  in the range of cells  

 

 
 

2. On the keyboard , press Ctrl + Shift + *  (note: on the keyboard..not keypad)  

 

3. The entire  list will be selected  
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MICROSOFT OFFICE EXCEL 2007 TOP 10 BENEFITS 

Microsoft Office Excel 2007 is a powerful and widely u sed tool that helps people analyze information to 
make more informed decisions. Using Office Excel 2007 and Excel Services, you can share and manage 
your analysis and insight with co -workers, customers, and partners with greater confidence.  

Here are the to p 10 ways in which Office Excel 2007 can help you create spreadsheets and analyze, 
share, and manage information more effectively.  

 

Office Excel 2007 features the Microsoft Office Fluent user interface to help you find 
powerful tools when you need them.  

Find the tools you want when you need them using the results -oriented Office Fluent user 
interface in Office Excel 2007. Based on the job you need to accomplish, whether itõs 
creating a table or writing a formula, Office Excel 2007 presents the appropriate commands 
when you need them.  

  

 

Import, organize, and explore massive data sets within significantly expanded 
spreadsheets.  

Work with massive amounts of data in Office Excel 2007, which supports spreadsheets that 
can be up to 1 million rows by 16,000 co lumns. In addition to the bigger grid, Office Excel 
2007 supports multicore processor platforms for faster calculation of formula -intense 
spreadsheets. 

  

 

Use the completely redesigned charting engine in Office Excel 2007 to communicate 
your analysis in  professional -looking charts.  

Build professional-looking charts faster with fewer clicks using charting tools in the Office 
Fluent user interface. Apply rich visual enhancements to your charts such as 3 -D effects, 
soft shadowing, and transparency. Create a nd interact with charts the same way, regardless 
of the application you are using, because the charting engine in Office Excel 2007 is 
consistent in Microsoft Office Word 2007 and Microsoft Office PowerPoint 2007.  

  

 

Enjoy improved and powerful support for working with tables.  

Create, format, expand, filter, and refer to tables within formulas because Office Excel 
2007 has greatly improved support for tables. When youõre viewing data contained in a 
large table, Office Excel 2007 keeps table headings in v iew while you scroll.  
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Create and work with interactive PivotTable views with ease.  

PivotTable views enable you to quickly reorient your data to help you answer multiple 
questions. Find the answers you need faster and create and use PivotTable views m ore 
easily by dragging fields where you want them to be displayed.  

  

 

òSeeó important trends and find exceptions in your data. 

Apply conditional formatting to your information more easily to discover patterns and 
highlight trends in your data. New sche mes include color gradients, heat maps, data bars, 
and performance indicator icons.  

  

 

Use Office Excel 2007 and Excel Services to help share spreadsheets more securely with 
others.  

Excel Services, a feature of Microsoft Office SharePoint Server 2007, dynamically renders a 
spreadsheet as HTML so others can access the information using a Web browser. Because of 
the high degree of fidelity with the Office Excel 2007 client, Excel Services users can 
navigate, sort, filter, input parameters, and interact wi th the information, all within their 
Web browser. 

  

 

Help ensure you and your organization work with the most current business 
information.  

Prevent the spread of multiple or outdated copies of a spreadsheet throughout your 
organization by using Office Excel 2007 and Office SharePoint Server 2007. Control which 
users can view and modify spreadsheets on the server using permission-based access. 

  

 

Reduce the size of spreadsheets and improve damaged file recovery at the same time.  

The new, compressed Microsoft Office Excel XML Format offers a dramatic reduction in file 
size, while its architecture offers an improvement in data recovery for damaged files. This 
new format provides a tremendous savings to storage and bandwidth requirements, and 
reduces the burden on IT personnel.  

  

 

Extend your business intelligence investments because Office Excel 2007 provides full 
support for Microsoft SQL Server 2005 Analysis Services.  
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Take advantage of the flexibility and the new cube functions in Office Excel 2007 t o build a 
custom report from an OLAP database. You can also connect to external sources of data 
more easily using the Data Connection Library.  
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HOW TO USE THE KEYBOARD AND NOT THE MOUSE WHEN USING AUTOFIL 

The fill handle is very helpful for filling ce lls with various values. Select some cells, click the fill 

handle, and drag it to fill cells in a variety of ways. If you hate to use the mouse there is a way of using 

the keyboard instead.  

Process: (2003 and 2007)  

1. Use the keyboard to select the cells on w hich you want the fill based.  
2. Hold down the Alt  key and select E, I, S that will display the Series dialog box.  

 

 
 

3. Use the Tab key and Arrows  to move from option to option within the dialog box.  
4. When you've chosen the option you want, press Enter  to select it.  
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HOW TO CONVERT DATA FROM CAPS TO PROPER STYLE USING THE PROPER FUNCTION 

Process: 2007 and 2003  

1. Insert a new column  
2. While on the first cell of the new column, select  Insert Function  

 

 
 

3. Under Category , select Text  
4. Select Proper  under Select a Function  
5. Select OK 
6. Under Text select the original data cell  

 

 
 

7. Select OK 
8. Autofill the data down by left clicking on the bottom right corner when the mouse forms a black 

cross 
9. If you want to delete the original column, Copy the new proper column, s elect Paste Special, 

select Values  
 
 

 

Insert Function 
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10. Now the column no longer references the original column and the Caps column can be deleted  

 

 

 

 

 

 

HOW TO SELECT THE RANGE AS A WHOLE, AND STILL EXCLUDE THE HIDDEN CELLS WHEN 

COPYING AND PASTING DATA IN EXCEL.  

Process: 2003 

Longer way:  

1. Select the range to copy  
2. Select Edit 
3. Select Go To 

 

Go To 
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4. Select Special 
 

 
 

5. Then select Visible cells only  
 

 

 



 

 

Website: www.alchemex.com    BI Community:  www.alchemex.ning.com    
  

Online Academy: www.alchemexacademy.com 
20 

 
 

6. Select OK 
7. Then Copy and Paste the cells as normal while higlighted  

Process 2007 

1. Select the range 
2. On the Home tab, in the E diting group, select Find & Select 
3. Select Go To Special 

 

 
 

4. Select Visible cells only  
5. Copy and paste as normal while highligted  
6. Ensure that you do not paste in an area that contains hidden rows  

Short cut method (for both Excel 2003 and 2007):  

1. For the keyboard equivalent, select the range, then select [Alt] and ; (hold down Alt while 
selecting the semi colon)  

2. Then copy and paste as normal 
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YOU CAN USE THE FIND AND REPLACE FUNCTION TO ALSO CHECK THE HEADER AND 

FOOTER AREAS OF A WORKBOOK BY USING A MACRO 

The Find And Replace  (keyboard shortcut CTRL + H) is a handy tool in every version of Excel and allows 

you to easily find certain text or values throughout your worksheet or workbook and automatically 

replace it with new text or values. However, the Find And Rep lace  tool doesnõt check the Header or 

Footer areas of your worksheet. The following macro will allow you to search the header and footer 

areas and make the changes you need to. 

Process (Excel 2003 and 2007):  

1. Record a new macro, giving it a valid, recognisa ble name 

2. In the macro, paste the following:  

Dim sWhat As String, sReplacment As String 
Const csTITLE As String = "Find and Replace" 
 
sWhat = InputBox("Replace what", csTITLE) 
If Len(sWhat) = 0 Then Exit Sub  
sReplacment = InputBox("With what", csTITLE) 
 
With ActiveSheet.PageSetup 

' Substitute Header/Footer values  
.LeftHeader = Application.WorksheetFunction.Substitute( _  
 .LeftHeader, sWhat, sReplacment)  
.CenterHeader = Application.WorksheetFunction.Substitute( _  
 .CenterHeader, sWhat, sReplacment)  
.RightHeader = Application.WorksheetFunction.Substitute( _  
 .RightHeader, sWhat, sReplacment)  
.LeftFooter = Application.WorksheetFunction.Substitute( _  
 .LeftFooter, sWhat, sReplacment)  
.CenterFooter = Application.WorksheetFunction.Substitute( _  
 .CenterFooter, sWh at, sReplacment)  
.RightFooter = Application.WorksheetFunction.Substitute( _  
 .RightFooter, sWhat, sReplacment)  
 
End With 

End Sub 
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3. When you run the macro, you will then be presented with two screens. The first will ask for the 

required search criteria:  

 

 
 

Enter the text youõre searching (in this example ôJanuaryõ) for and click OK.  

 

4. A second screen will then be presented asking for the required replacement value:  

 

 
 

Enter the replacement text (in this example ôFebruaryõ) for and click OK. The macro will n ow 

take those two values and search the header and footer areas on this worksheet and make the 

appropriate replacements.  
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WITH CONDITIONAL FORMATTING YOU CAN HAVE CELLS CHANGE COLOUR BASED ON HOW 

CLOSE THE DATE IN THE CELL IS TO TODAYõS DATE 

Process: Excel 2003  

1. Select cell containing the date. NB: for this example, todayõs date is 19th February, 2009. 

 

2. Choose Conditional Formatting from the Format menu. Excel displays the Conditional 
Formatting dialog box.  

 

3. Set Condition 1 so that Cell Value Is Equal To =TODAY(). Note that you must, in the right -most 
box, enter an equal sign followed by the TODAY() function.  

 

4. Click on the Format button. Excel displays the Format Cells dialog box. Make sure the Patterns 
tab is selected. Choose the red colour you want to us e and click OK to close the Format Cells 
dialog box.  
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5. Click on the Add button.  
6. Set Condition 2 so that Cell Value Is Between =TODAY()-7 And =TODAY()+7. Note that you must 

use equal signs in the two right -most boxes otherwise Excel wonõt recognise it as a formula.  
7. Click on the Format button. Excel displays the Format Cells dialog box. Make sure the Patterns 

tab is selected and choose a yellow colour. Click OK to return to the Conditional Formatting 
window.  

 

8. Click on the Add button.  
9. Set Condition 3 so that Cell Value Is Between =TODAY()-14 And =TODAY()+14. Again, you must 

include the equal signs to indicate you are entering formulas.  
10. Click on the Format button. Excel displays the Format Cells dialog box. Make sure the Patterns 

tab is selected and choose the green colour you want to use. Click OK to close the Format Cells 
dialog box.  
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11. Click on OK. If the date is within 14 days either side of todayõs date, the cell will be given the 
appropriate colour.  

Process: Excel 2007  

1. Select cell containing the date. NB: f or this example, todayõs date is 19th February, 2009. 

 

2. On the Home tab, under the Styles group, select Conditional Formatting, select  New Rule. 
Excel displays the Conditional Formatting dialog box.  
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3. Set the condition so that Cell Value Is Equal To =TODAY(). Note that you must, in the right -
most box, enter an equal sign followed by the TODAY() function.  

 

4. Select the Format button. Excel displays the Format Cells dialog box. Make sure the Fill  tab is 
selected. Choose the red colour you want to use and click  OK to close the Format Cells dialog 
box. 

 

5. The Conditional Formatting Rules Manager will then appear, which lists all conditional format 

rules. Click on New Rule in the top left hand corner.  
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6. Set Condition 2 so that Cell Value Is Between =TODAY()-7 And =TODAY()+7. Note that you must 
use equal signs in the two right -most boxes otherwise Excel wonõt recognise it as a formula. 

7. Click on the Format button. Excel displays the Format Cells dialog box. Make sure the Patterns 
tab is selected and choose a yellow co lour.  

8. Click OK to return to the New Formatting Rule window.  
9. Click OK to return to the Conditional Formatting Rules Manager window.  

 
 

10. Click on New Rule in the top left hand corner.  Set Condition 3 so that Cell Value Is Between 
=TODAY()-14 And =TODAY()+14. Again, you must include the equal signs to indicate you are 
entering formulas.  

11. Click on the Format button. Excel displays the Format Cells dialog box. Make sure the Fill  tab is 
selected and choose the green colour you want to use. Click OK to close the For mat Cells dialog 
box. 
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12. Click OK to confirm the new conditional formatting rule.  

13. Click OK to confirm these rules in the Conditional Formatting Rules Manager window.  

NB: Excel 2003 can only have three conditional formatting rules per cell, whereas Excel 20 07 can have 

an unlimited number of conditional formatting rules (up to available system memory) per cell, 

providing more options for date ranges etc.  

 
 

EXCEL CAN GRAPHICALLY SHOW DATA WITHOUT USING CHARTS. IN EXCEL 2007  YOU CAN 

USE CONDITIONAL FORMATTING, AND IN EXCEL 2003 YOU CAN USE THE REPT FUNCTION 

TO ACHIEVE SIMILAR RESULTS.  

Process: 2003  

1. While in the cell next to data you want to graphically display, select Insert Function:  
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2. Under Category, select Text and then select the function REPT  
 

 
 

3. Enter data as below:  
 

  
 

4. Text is the character that will be repeated  
 

5. Number_Times refers to the number of times the character will be repeated.  In this case we are 
referring to data in another cell  
 

6. Select OK 
 

7. Result will be similar to below..depending on wh at text was selected:  
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8. Much easier to see who is the star salesman! 
 

Process: 2007  

1. The above process can be repeated similarly in 2007, or you can make use of Conditional 
formatting  
On the Home tab, select Conditional Formatting, Data bars while on the cell you want to 
graphically display  
 

 
 
This will leave you with the following result:  
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2. When using the REPT function, you are not restricted to only keyboard characters, but can also 
insert characters from the character map:  

 

 
 
 

BY USING THE AUTOFILL FEATURE THERE IS A WAY TO CALCULATE THE LAST DATE OF A 

MONTH FOR A RANGE OF MONTHS AUTOMATICALLY WITHOUT USING A FUNCTION 

Process (MS Excel 2003 and 2007):   

1. Select cell A1 and type in the last day of the month (in this example, 31 st March, 2009). 
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2. Select cell A2 and type in the last day of the next month (in this example, 30 th April, 2009).  

 

3. Highlight both cells  to show Excel the trend you want .  
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4. Use the AUTOFILL handle and drag down the required number of months (in this example, another 

six months to October, 2009).  

 

 

BY USING THE EOMONTH FUNCTION IT WILL CALCULATE THE LAST DATE OF A MONTH 

AUTOMATICALLY 

Process (MS Excel 2003 and 2007):   



 

 

Website: www.alchemex.com    BI Community:  www.alchemex.ning.com    
  

Online Academy: www.alchemexacademy.com 
34 

The EOMONTH function is used to return the serial  number value of the last day of any month, past, 

present or futur e. Once the value is returned, you can change the format of the cell to òDATEó and it 

will then give you the end of the month in date format.  

1. Select cell A1 and type in =EOMONTH(NOW(),0). 

 

The function follows the following format:  

=EOMONTH(base,offset) 

The base value in the formula is a date  to be used to identify the month in question. You could even 

use the NOW() function to return todayõs date. 

The offset value can be used to move the month in question in the base value. For example:  

2. Select cell A2 and type in =EOMONTH(A1,6). 

 

The 6 value in the base criteria moves the function six months forward, hence the final date of 

September, which is six months ahead of March (which was worked out by using the NOW() function). 

This operation could be done with one formula, nested in the following way:  
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=EOMONTH(NOW(),6) 

You could also use a negative number to get to months prior to the one being used in the base criteria.  

NB: In versions of MS Excel prior to MS Excel 2007, the EOMONTH function can only be used by installing 

the Analysis Toolpak, an add-on utility that you can select when you install MS Excel. If the formula 

returns an error in Excel 2003 when you use it, you will need to use the MS Office installation disk to 

install the Toolpak.  

 

THE ôMERGE AND CENTREõ FORMATTING OPTION IS NOT AVAILABLE IN EXCEL DURING 

NORMAL USE. TO MAKE IT AVAILABLE THE SHARINGõ AND ôPROTECTIONõ SETTINGS NEEDS 

TO BE CHECKED ON. 

 

The ôMerge and Centreõ function is a great formatting tool used by almost every Excel, but occasionally 

it can be greyed out and be unavailable to use. If this happens, the two options to check are whether 

the workbook is shared and whether it is protected.  

 

Worksheet Protection:  if a worksheet is protected, a number of formatting features are disabled 

(depending on the level of protection) which could make ôMerge and Centreõ unavailable. 

 

 

Excel 2003:  

 

1. Select Tools é Protection é Protect Sheet 
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2. Check that the ôFormat Cellsõ option is not ticked. If it is, click once in the tick box to remove the 

tick.  

 

 
 

Excel 2007:  

 

1. On the Review  tab, under the Changes group, select Protect Sheet  

 

 
 

2. Check that the ôFormat Cellsõ option is not ticked. If it is, click once in the tick box to remove the 

tick.  
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Workbook Sharing:  if a workbook is shared, it can also h ave the effect of making ôMerge and Centreõ 

unavailable. To remove sharing, follow these steps.  

 

Excel 2003:  

 

1. Select Tools é Share Workbook  

 

 
 

2. Remove the tick next to the ôAllow Changesõ option. 
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Excel 2007:  

 

1. On the Review  tab, on the Changes group, select Share Workbook  

 

 
 

2. Remove the tick next to the ôAllow Changesõ option. 
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BY ALTERING THE FULL NAME OF THE NAMED RANGE YOU CAN USE THE SAME NAMED 

RANGE ON DIFFERENT SHEETS OF THE SAME WORKBOOK 

Process (Excel 2003 and 2007):   

Excel 2003 

1. Select the cells that you would like to create a Named Range for, then select Insert é Name é 

Define  

 

 
 

2. In the ôNames in workbookõ box, type in the name for your range and add the sheet name with 

an exclamation mark at the end (e.g. Sheet1!MyRang e).  

 

 
 

3. Select Insert é Name é Define. You will now see that the range now has a reference to the 

particular sheet that was referenced in step 2.  
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This process can be done on each sheet, allowing you to use the same name for named ranges on 

multiple shee ts.  

 

Excel 2007 

 

1. Select the cells that you would like to create a Named Range for,  on the Formulas  tab, in the 

Defined Names  group, select  Define Name.  

 

 
 

2. In the ôNew Nameõ box, click the drop down option for Scope and select the desired sheet. This 

will limit the Named Range to the selected sheet, allowing it to be used on other sheets as well.  
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BY USING A COMBINATION OF THE MOD FUNCTION AND CONDITIONAL FORMATTING YOU 

CAN SHADE CELLS BASED ON ODD OR EVEN VALUES 

 

Process (Excel 2003 and 2007) :   

The MOD function is used to find the remainder of a number after it has been divided by another 

number.  

 

Format:  MOD(number,divisor)  

E.g.  MOD(10,2) = 0 

 

We can use this remainder function to determine whether the number in a cell is odd or even.  

 

Excel 2003  

 

1. Highlight the range of cells you would like to apply conditional formatting to, then click on 

Format é Conditional Formatting 

 

 
 

2. Change condition 1 to òFormula Isó and in the formula field type =MOD(A1,2)=1. This will 

return a TRUE if there is a  odd number in the cell  
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3. Click on the FORMAT button, and then select the Patterns  tab. Choose a colour and click OK 

 

 
 

4. The range of cells should still be highlighted at this stage.  

 

5. Click on the ADD button  

 

 
 

6. For Condition 2, set the drop down to Formula Is  and in the text box enter =MOD(A1,2)=0. 

This will highlight any even cells 
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7. Click on the FORMAT button for Condition 2, and then select the Patterns  tab. Choose a 

different colour and click OK 

 

 

 

Excel 2007 

 

1. Highlight the range of cells you would like to apply conditional formatting to, then click on the 

Home tab of the  Office Ribbon and select Conditional Formatting  and select New Rule  

 
 

2. In the ôSelect a Rule Type:õ area, select Use a formula to determine which cells to format.  In 

the ôFormat values where this formula is true:õ area, type in =MOD(A1,2)=1. This will highlight all odd 

cells 

 








































































































































